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1.  Creating Custom Printer Calibrations and Profiles 

1.1  Introduction 

GMG ColorProof comes with predefined GMG Proof Media types for all commonly used proof printers. GMG 
provides standard color management sets for GMG Proof Media and for all proof printers suitable for meeting 
even the highest quality demands for contract proofing. All GMG color profiles were set up and tested by 
GMG Color Experts. GMG emphasizes not only on reaching the correct color values, but also on matching the 
visual appearance of the final print result as closely as possible. 

Furthermore, GMG ColorProof enables you to set up custom print media and custom (in-house) standards. Use 
GMG ProfileEditor to create your own MX based printer calibration files and proof profiles. 

In this tutorial, you will learn how to create a custom printer calibration and proof profile for a generic printer 
in combination with your custom proof medium. This tutorial also includes a short documentation on how to 
calibrate your printer with GMG CaliWizard. 

Note:  Some of the features described in the following are not included in the standard GMG ColorProof 
version and require an additional license (Media Manager 05, GMG DotProof, GMG FlexoProof, or 
GMG ColorServer). Please contact your local dealer for details. 

Note:  Use of custom media is supported only by GMG ColorProof 05 Standard Version or higher licenses. 
GMG ProfileEditor is included only in GMG ColorProof 05 Pro Version or higher licenses. 

1.2  Components Used in this Tutorial 

In this tutorial, the following components will be used as typical examples. Of course, you can create printer 
calibrations and profiles likewise for any other printer–medium combination or measuring device. Just take care 
to use the appropriate test charts for the printer and measuring device. 

 Printer: Epson Stylus Pro 4880 with Photo Black ink 

 Measuring device: X-Rite Eye-One iSis 

Printer specific differences 

Multicolor printers with additional (non-CMYK) inks such as Epson Stylus Pro x900 series and HP Designjet 
Z3200 use a slightly different color management technology. Therefore, they have special requirements for 
creating printer calibrations and proof profiles, though the general procedure as described in this tutorial still 
applies. You will find more information in the following tutorials. 

See also: 

• GMG-CP05_HowTo_Epsonx900-Epson-Driver_en.pdf, GMG-CP05_HowTo_HPZ3200_HP-Driver_en.pdf 

1.3  Spectrophotometer Settings 

UV light affects color measurements made with spectrophotometers. Therefore, spectrophotometers can have 
integrated UV cut filters that may achieve more reproducible results in the visible color space. GMG software is 
capable of working with UV and non-UV measuring devices. 

Some measuring devices are available either with or without UV filters. Other measuring devices support 
switching the UV cut filter on and off. For more information on the supported hardware settings, please refer to 
the specification of the spectrophotometer's manufacturer. 

Use of a measuring device for profile making 

The measuring device type and use of filters will result in different measurement values. Therefore, it is very 
important that an appropriate profile is used and all measurements are made with the same device and filter 
settings. When creating a proof profile, all measurement steps should be performed with the same type of 
measuring device and with identical UV cut filter settings. The corresponding gamut file, created with the same 
measuring device type and UV cut filter settings, must be used for all calculation steps during profile making. 
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If you intend to modify an existing proof profile, the measuring device used for the modification has also to be 
identical to the one that was used when creating the original profile. Therefore, it is recommended to enter all 
relevant parameters and conditions, such as the measuring device type and UV cut filter settings, into the 
Specification edit box of the profile for later reference. 

Use of a measuring device for printer calibrations 

The printer calibration file settings can be independent from the proof profile. This means, you can create a 
printer calibration file for a different measuring device than the one you have used for proof profile making. 
This way, you can use a measuring device that suits your needs for calibrating the printer on a regular basis. 
The achieved calibration status will then be valid for all proof standards based on the same printer–medium 
configuration, independent from the measuring device settings. 

Use of a UV cut filter 

If the medium used for the target print production process simulated in the proof contains a high amount of 
optical brighteners, it is recommended to use a UV cut filter when creating the corresponding proof profiles. 
Otherwise, use of a UV cut filter is not required. 

The ISO 12647-7 standard specifies that no UV cut filters should be used for producing hard-copy digital proof 
prints intended to simulate a printing condition. 

Backing methods 

As most print media are not 100% opaque, the color of the substrate, for example, the measuring table, 
underneath the test chart also affects the measurement values and thus the color profile. Generally, it is 
recommended to use white backing for single-sided prints. As the backing affects the color measurement, it is 
very important that an appropriate profile is used and all measurements are made with the same device and 
backing. 

GMG recommends to use white backing (for example, with GMG ProofPaper semimatte 250) when creating a 
proof profile. The ISO 12647-7 standard specifies that white backing should be used for producing hard-copy 
digital proof prints intended to simulate a printing condition. 

Tip:  If you have a measuring device in use that supports only black backing, simply place a highly opaque 
sheet of white medium, for example, GMG ProofPaper semimatte 250, underneath the test chart. Preferably, 
this medium should have a lightness (L*) value of 94 or higher, without optical brighteners. 

1.4  Calibration File Formats 

The following GMG calibration file formats exist for different printers and printer drivers. Different test charts 
are printed according to the file format and printer. 

File 
Format 

Printer 
Driver 

Printer Types 

*.MX3 GMG 
Driver 

4 color and multicolor printers based on CMYK inks such as Epson Stylus Pro 4000, x400, x450, x600, x800, x880, 
11880, and HP Designjet 130, 5000, 5500, Z2100. Compatibility mode (for x880 printers) of the GMG Driver for Epson 
Stylus Pro x900 series in 4/8 color mode. 
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2.  Creating a New Printer Calibration for Custom Media 
As a closed system, the GMG system comprising GMG ColorProof, GMG Proof Media, printer calibrations and 
printer drivers, and proof profiles developed by GMG ColorExperts guarantees highest print quality and color 
accuracy. However, GMG also offers starter kits that allow you to easily create your own custom printer 
calibrations and use custom media with satisfying print results. The latest starter kits can be found on the 
GMG website, Support area > File Downloads. 

Different starter kits are available for each printer. Each starter kit has been optimized for a different paper type. 

Starter kit Proof medium type 

Photo Black Coated media 

Matte Black Uncoated media 

Matte Black, 4 colors (4c) Newspaper media (or any media with lower ink uptake capabilities) 

2.1  Creating a New MX3 Printer Calibration 

The following chapters will help you to create a new MX3 printer calibration file for a generic printer type 
together with GMG Driver for the support of custom media. 

The following steps are required for creating the MX3 printer calibration file and the gamut and full gamut file. 

Step Short description See also 

Choosing a suitable 
media type and print 
mode 

Choose a media type that closely resembles the print medium you want to use and a print 
mode that is suitable for your application. 

"Choosing a Suitable 
Media Type and Print 
Mode" on page 7 

Setting up the printer 
hardware and 
software settings 

Select the suitable media type in the printer's front panel and in the software. Define the 
job defaults for the printer settings in the software. 

"Preparations" on page 
10 

Checking the selected 
media type and print 
mode (overinking, 
TAC) 

Print a test image from the starter kit. Change print mode and/or media type if necessary. "Testing the Total Area 
Coverage of the Printer–
Medium Combination" 
on page 11 

Creation of the full 
gamut file (printer 
= not calibrated) 

Print a TC4 full gamut test chart (according to the measuring device) with linear MX4 and 
linear MX3 from the starter kit (according to the results of the TAC test). In GMG 
ProfileEditor, import the measured data into a new empty MX4 profile and export the full 
gamut csc file. 

"Creating the Full Gamut 
File" on page 13 

Creation of the MX3 
printer calibration 
file 

Print a TC3 printer calibration test chart (according to the measuring device) with linear 
MX4 and MX3 (acc. to TAC) from the starter kit. In GMG ProfileEditor, import the 
measured data as Target Values into the MX3. 

"Creating Target Values 
for Printer Calibration" 
on page 16 

Creation of the gamut 
file (printer 
= calibrated) 

Print an ECI2002 gamut test chart (according to the measuring device) with linear MX4 
and with the new created MX3. In GMG ProfileEditor, import the measured data into a 
new empty MX4 profile and export the gamut csc file. 

"Creating the Gamut File 
for MX4 Color Profiles" 
on page 18 

Creation of the MX4 
proof profile 

Create a new empty MX4 and link it to the gamut file. Import the characterization data as 
Target Values. Calculate the output values (Calculate with Target Values). Optimize the 
profile in an iterative process (cycle): Print an ECI2002 test chart with the new MX4 and 
new MX3. In GMG ProfileEditor, measure the patches with an external measuring device. 
Compare the Target Values with the Current Values and adjust the output values 
accordingly (Calculate with Target and Current Values). Repeat the process until the 
deviation (delta E) between Target Values and Current Values is ok.  

"Creating an MX4 Proof 
Profile—Short Summary" 
on page 24 

2.2  Test Charts 

GMG Color GmbH & Co. KG provides test charts for all supported printers and measuring devices. All test 
charts can be found in the Testcharts subfolder of the main ColorProof program folder. 

GMG test charts use the following naming convention: GMG_<test chart type>_<random/visual>_<measuring 
device> _<version No.>_<total No. of pages>_<page No.>, for example 
GMG_TC4_random_Spectro_2pages_p1.tif. 

Placeholder Meaning 

GMG  GMG is used in the file name of all test charts created or optimized by GMG Color GmbH & Co. KG.  

test chart type Different test chart types are used for different steps when creating a printer calibration or proof profile. 

http://www.gmgcolor.com/gmgcolor/index.php?id=60&L=2�
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Placeholder Meaning 

random/visual In Random test charts, patches have been randomized to avoid influences of inhomogeneous printings to the 
measurements. It is recommended to use Random test charts if available. 

measuring 
device 

Use only test charts intended for use with the measuring device you are using. 

version No. In some cases, multiple versions of a test chart, denominated as V1, V2, etc. are available. It is recommended to use the 
latest version. 

total No. of 
pages 

In some cases, a test chart does not fit the printable area of a printer or the readable area of the measuring device. In these 
cases, the test chart is provided tiled into multiple pages. For example, 2pages means that the test chart is tiled into two 
separate test chart files. 

page No. Page number of a multi-page test chart file. Make sure you print all pages of a multi-page test chart. 

2.2.1  Test Chart Types 

Type Usage 

TC4  Measuring the full gamut of a printer–medium combination. The TC4 test chart includes more color patches than the ECI2002 
chart, with the focus on patches important for the printer calibration file. 

CMY-
Gamut  

Measuring the gamut or full gamut of the printer–medium combination, only for HPZ3200 + HP Driver. 

TC3 Measuring the target or current values for an MX3 printer calibration file. 

TC3-K  Measuring the target or current values for an MX4 printer calibration file. TC3 with additional K patches, only for Epson Stylus 
Pro 7900, 9900 + Epson Driver. 

TC3-MXC  Used internally by the program when calibrating a printer with an MXC printer calibration file. (MXCs cannot be edited in 
GMG ProfileEditor.) 

ECI2002 Measuring the gamut of a printer–medium combination. Also for measuring the target or current values when creating an 
MX4 proof profile. 

SpotColor  Measuring the target or current values when creating a spot color profile in GMG SpotColor Editor. 

DotGain Measuring the current values for the Dot Gain when creating an MX5 proof profile. 

2.3  Choosing a Suitable Media Type and Print Mode 

It is very important to choose the correct media type and print mode for defining the printer–medium 
combination right from the beginning and to use the same media type for all subsequent steps (creation of 
printer calibration, in print jobs, in hotfolders). 

After setting up the printer hardware and software, it is recommended to make a test print with the selected 
media type and print mode. If the test fails, try to use a different print mode. If you cannot find a print mode that 
generates satisfying results, try a different media type. 

Selecting an incompatible media type can result in print quality issues such as overinking. Please consider that 
the custom medium you want to use might not be supported by the printer. 

2.4  Creating a New Print Medium 

Tip:  When creating a new medium, it is recommended to duplicate an existing printer–medium 
combination with a comparable media type and use this as a template. The Media Thickness and the Paper 
Feed Adjustment are the most important parameters that should be verified for the new media type. In most 
cases, all other parameters can be left unchanged. 
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Fig. 1 Definition of printer–medium combinations. 

You can set up custom media types under any name (1). You can then define available media sizes as a global 
property of this medium type, for all printers) (2). You can also define new custom media sizes (3) or delete 
sizes (for all printers).  
The media type (with all sizes) needs to be assigned to printer types (4). In this example, GMG ProofPaper 
semimatte 250 is assigned to all available printer types. 
(In the Media list in the System view, only the formats will show up that are supported by this printer–medium 
combination. Only supported media sizes will be available for printing a job.) 
You can also set up printer–medium combinations for printers that have not been installed yet. Select Show All 
Printers (5) to update the list will all printers that are supported by GMG ColorProof. 

How to create a new print medium 

1. Click the System button on the navigation panel on the left of the main window. Click the Media tab. 
The Media page shows a list with all printer–medium combinations available in the database. 

2. Select an existing printer–medium in the list, based on the printer you want to use and on a comparable 
new medium type. On the System menu, point to Print Media and click Duplicate. 
—OR— 
If you are unsure about a comparable medium type, create a new printer–medium combination from 
scratch. On the System menu, point to Print Media and click New. 

3. Type in a Media Name. 

4. Select the media sizes that are supported by this medium in the Available Media Sizes list. 

5. (Click Show All Printers if you have not installed the desired printer in GMG ColorProof yet.) Select all 
printers that support this medium on the Available Printers list. 

6. After creating the new medium, you need to define the Advanced Media Settings for all printer–medium 
combinations you have created in step 4. 
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How to define the Advanced Media Settings for printer–medium combinations 

1. Select the new created printer–medium combination, in this example, Epson Stylus Pro 4880 – Custom 
Medium 1, from the Media list and click the Advanced Media Settings button on the toolbar. 

 
The Advanced Media Settings dialog box is displayed. 

2. Define parameters such as the media thickness or paper feed for the selected printer–medium 
combination. If you are unsure, keep the default settings and change the settings only if you experience 
any problems. For HP Z printers: Select a Parent Paper from the drop-down list. 

3. Select the next printer–medium combination in the list, in this example, HP Designjet Z2100 Photo 24'' – 
Custom Medium 1. Repeat this procedure for all new printer–medium combinations. 

4. You can then proceed to the next step and define a calibration set and a proof standard for all new 
printer–medium combinations. 

See also: 

• "Advanced Media Settings" on page 9 

2.5  Advanced Media Settings 

The Advanced Media Settings defined for each printer–medium combination such as the media thickness, 
paper feed, cutting pressure, are the defaults for this printer–medium combination. When changing the medium 
in the software printer, the defaults are automatically extracted from the database.  
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You can change the settings for a specific printer in the Advanced Printer Settings dialog box (Output > 
Printers > Configure), for compensating the (unusual) behavior of this particular printer. This will not change 
the default settings (Advanced Media Properties in the System settings) for this printer–medium combination. 
This printer specific settings are only saved until the next paper change. When changing the paper, all 
advanced media settings are reset to the defaults. 

Tip:  When creating a new medium, it is recommended to duplicate an existing printer–medium 
combination with a comparable media type and use this as a template. The Media Thickness and the Paper 
Feed Adjustment are the most important parameters that should be verified for the new media type. In most 
cases, all other parameters can be left unchanged. 

Available 
options 

Printer Type Description See 
also 

Drying time 
per Print Head 
Pass 

Epson The drying time per pass is the time the printer carriage remains (after one pass is printed) at one side 
of the printer before the printing of the next pass begins. In other words the printer waits the specified 
time until it prints the next line. This ensures that the print medium is completely dry and avoids ink 
running from one line to another. The ideal drying time depends on the print medium and ink set. 
Generally, a drying time per pass may range between about zero and two seconds. GMG ColorProof 
provides default drying times for each supported printer–medium combination. if you are experiencing 
problems with ink pooling, you can increase the drying time between print head passes. 

  

Drying time 
per Page 

Epson 7600, 
9600, 4000, 
x450, x800, 
x880 

After printing a job, the printer waits the specified drying time until the printed job is fed out of the 
printer (or cut from the roll) and the next job is started. This ensures that the print medium is 
completely dry and avoids ink smudging from one page to another. The ideal drying time depends on 
the print medium and ink set. GMG ColorProof provides default drying times for each supported 
printer–medium combination. 

  

Vacuum  Epson If you are experiencing artifacts due to ink deflection and splatter, this might be caused by a too high 
vacuum, which increases the distance the ink has to travel before it reaches the medium (because the 
suction is distorting the medium).  

  

Media 
Thickness 

Epson Thickness/caliper of the print medium in mm. Use the Media Thickness as specified by the 
manufacturer of the print medium. As a rule of thumb, you can also use the grammage of the medium 
in micrometers (μm), rounded up to 1/10 of a mm or [Grammage / 1000] mm for standard weight 
media. For example, GMG ProofPaper semimatte 250 has a caliper of about 250 μm = 0.3 mm. 

  

Paper Feed  Epson The optimum Paper Feed depends on the media weight and thickness. To evaluate the Paper Feed, 
you can print out an image with a vertical length of 1000 mm and then measure the length of the 
printed image. The measured length is the Paper Feed. 

  

Paper Feed 
Adjustment  

Epson The Paper Feed Adjustment fine-tunes the Paper Feed and thus helps to reduce banding. If you are 
experiencing microbanding problems with a specific medium (gaps or overlapping in the print), you 
can fine-tune the paper advance with the Paper Feed Adjustment. 

 

2.6  Preparations 

2.6.1  Printer Software Settings 

The printer settings in GMG ColorProof define the default parameters for all jobs created for this printer. 
Therefore, it is recommended to first define all settings that are identical for all jobs printed during the following 
steps. In each step, only parameters that differ from the general settings will be pointed out to you. 

Note:  Make sure to use identical job settings (printer type, media type, print mode) in all steps when creating 
the printer calibration, when calibrating the printer later, and for all print jobs that will use the created printer 
calibration file. 

Note:  A sufficient drying time is important for a good result. For the creation of the full gamut and gamut files, 
GMG recommends a minimum drying time of 15 minutes. For the printer calibration file, 5 minutes are 
sufficient. 

How to set up the general printer/job settings 

1. In GMG ColorProof, click the Output button on the navigation panel on the left of the main window. On 
the Printers tabbed page, Available Printers list, double-click the printer you want to use.  

2. On the General Settings tabbed page, under Connection, select Type TCPIP and enter the IP address of 
the printer into the Address field. 

3. Confirm by clicking OK. 

4. Click the Change Medium button on the right side of the Printers list. 
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5. Select the desired media type. 

6. Select the media size of the loaded medium. 

 

2.7  Testing the Total Area Coverage of the Printer–Medium Combination 

The goal of this test is to evaluate the physical limitations on ink uptake of the printer–medium combination. As 
a result of this step, an MX printer calibration file from the starter kit will be identified as ideal color profile for 
creating the target values for the final printer calibration file. 

A test page with multiple test images (white lines set against a dark background) that show different levels of ink 
application (CMY and K) is printed. The test page is printed without any color management (linear color profile, 
no printer calibration). A visual check of the printed test page allows to decide which TAC is supported by the 
printer–medium combination. 

 
Fig. 2 Test page for TAC check. 

The CMY values below the test images specify the TAC. A base MX3 printer calibration file is provided for each 
TAC in the starter kit. 

Select the test image with the highest TAC that shows no overinking and gives a good print result. The white 
lines should appear sharp and crisp. You can print the test page on a standard printer with standard color profile 
and calibration for comparison. 

How to create a job for the test image 

1. Create a new job in GMG ColorProof and add the image InkCoverage.tif from the starter kit to the job. 
When creating the job, ignore the settings in the New Job dialog box. You will configure the job and 
image settings in the Manual Job Manager. 

2. Job > Printer Settings > Printer: From the Printer list, select the installed printer you want to use, for 
example, Epson 4880. 

3. Job > Printer Settings > Printer: From the Medium list, select the loaded medium. 



GMG ColorProof How to Create a Printer Calibration from a Starter Kit   

12   

4. Job > Printer Settings > Printer: Under Printer Calibration, select the linear printer calibration file from 
the starter kit (for example, Epsonx880_8c_V1_linear.mx3).  

 

5. On the Advanced tab of Job > Printer Settings, make sure the printer settings are correct, for example "8c - 
Photo Black - 720 dpi - Bidirectional". 
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6. Image > Color Management > Proof Output:  From the Medium list, select Custom. Under Profile (MX 
DeviceLink / ICC Input, select a linear MX4 (default path: C:\Program 
Files\GMG\ColorProof05\Profiles_Linear\CP_linear.mx4). 

 

7. Click OK to print the job. 

The test image with the highest CMY value that still shows no overinking and gives a good print result specifies 
the TAC for this printer–medium combination. The corresponding MX3 printer calibration file will be used as a 
starting base in the step "Creating the Target Values for Printer Calibration". For example, if a total area coverage 
of 240 provided the best print results, use "<calibration file name>_240.mx3" for the following steps. 

2.8  Creating the Full Gamut File 

As a result of this step, the full gamut file for this printer–medium combination will be created. The full gamut 
file will be linked to the final MX printer calibration file in a later step. It defines the relationship between 
output values (sent to the printer) and resulting color values when calibrating the printer with the printer 
calibration file in GMG CaliWizard or AutoCali Wizard. 

In this step, the full gamut test chart (GMG_TC4_random_iSis.tif) for this printer is printed without color 
management (linear MX4) and without printer calibration. Thus, the input values (from the color patches of the 
test chart image) are equal to the output values (the color values the software outputs to the printer driver).  

The measurement values for the fulcrums in the test chart describe the full gamut of this printer–medium 
combination. Thus, the full gamut file describes the color space that the printer is able to print according to its 
technical specifications and according to the medium and print mode in the "neutral state" before calibration. 

It is recommended to print the test chart twice and average the results to achieve a reliable result. 

For averaging the measured data and exporting it into a full gamut file, an empty MX4 profile is required. The 
measured data is loaded into the empty MX4 as Target Values in GMG ProfileEditor. The Target Values can 
then be exported as the Full Gamut file.  
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How to create the job for printing the full gamut test chart 

1. Create a new job in GMG ColorProof and add the appropriate full gamut test chart for the printer (for 
example, GMG_TC4_random_iSis.tif) from the Testcharts subfolder of the Colorproof main folder to the 
job. 

 

2. Ignore the other options in this dialog box and click Open to edit the job in the Manual Job Manager. 

3. Job > Printer Settings > Printer: From the Printer list, select the installed printer you want to use, for 
example, Epson 4880. 

4. Job > Printer Settings > Printer: From the Medium list, select the loaded medium. 

5. Job > Printer Settings > Printer: Under Calibration Set, select Custom. Under Printer Calibration, select 
the linear MX3 from the starter kit, for example, Epsonx880_8c_V1_linear.mx3. 
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6. On the Advanced tab of Job > Printer Settings, make sure the print mode uses the correct driver, for 
example "8c - Photo Black - 720 dpi - Bidirectional". 

 

7. Image > Color Management > Proof Output:  From the Medium list, select Custom. Under Profile (MX 
DeviceLink / ICC Input, select a linear MX4 (default path: C:\Program 
Files\GMG\ColorProof05\Profiles_Linear\CP_linear.mx4). 

 

8. Click OK to print the job. 

How to repeat the measurement for averaging measured data 

• In the GMG ColorProof History view, select the printed job and print the test chart again. 

How to measure the data from the test chart (with an external measuring device) 

1. Start GMG ProfileEditor. 

2. On the File menu, click New CMYK MX4. 

3. Select the used printer type, for example, Epson Stylus Pro 4880 from the Printer list. 

4. Select the used measuring device, for example, Eye-One iSis, from the Measuring Device list. 

5. Under Measurement Chart, select TC4. 
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6. Click OK to create the new profile. 

 

7. On the Measure menu in GMG ColorProof, click All Target Values. 
The test chart measurement dialog box opens. 

8. Click the browse button and browse your folders. In the templates folder, select the chart template 
corresponding to the test chart (with the same name), for example, GMG_TC4_random_iSis.tpl. 

9. Insert the test chart printed in the first job into the measuring device. 

10. Click the Measure button. 
The test chart is measured. Measured data is read as Target Values into the open MX4 file. 

11. On the Import/Export menu, point to Export Target Values, and click Text File. 

12. Save the file as xx_fullgamut_1.txt file. 

13. Insert the test chart printed in the second job into the measuring device. 

14. Repeat steps 5 and 6. 

15. Save the file as xx_fullgamut_2.txt file. 

How to convert the measured data to a full gamut file 

1. In GMG ProfileEditor, open the new MX4 file again (or create a new one as described above). 

2. On the Import/Export menu, click Import Target Values. 

3. Browse your folders and select the xx_fullgamut_1.txt and xx_fullgamut_2.txt files while holding down the 
SHIFT key (multi-select). 
The measured data from all selected files is automatically averaged and loaded into the MX4 as Target 
Values. 

4. If an error message about missing fulcrums is displayed, confirm it with OK. 

5. On the Import/Export menu, point to Export Target Values, and click Gamut File. 

6. Save the full gamut file under an appropriate file name, for example, as Epson_4880_<print 
mode>_<medium>_V1_<measuring device> _<UVcut>_fullgamut.csc into the same folder where you 
saved the printer calibration file. 

The resulting full gamut file will be linked to the final MX3 printer calibration file in the step "Creating Target 
Values for Printer Calibration". 

2.9  Creating Target Values for Printer Calibration 

A TC3 test chart is printed with the calibration file from the starter kit. The calibration file defines the output 
values, that is, the values that the printer should print for each color patch in the test chart in order to achieve 
the correct color value in the print and to avoid overinking. 

The print result of this test chart serves as the reference for all further prints with this printer–medium 
combination. 

The full gamut file is linked to the printer calibration file in GMG ProfileEditor so that it can be used by GMG 
CaliWizard or AutoCali Wizard. 
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You can use the printer calibration file created in this step as Initial Calibration of a calibration set. 

How to create the job for printing the test chart and measuring the target values 

1. Create a new job in GMG ColorProof and add the appropriate calibration test chart for the printer (for 
example, GMG_TC3_random_iSis.tif) from the Testcharts subfolder of the main program folder to the job. 

 

2. Ignore the other options in this dialog box and click Open to edit the job in the Manual Job Manager. 

3. Job > Printer Settings > Printer: From the Printer list, select the installed printer you want to use, for 
example, Epson 4880. 

4. Job > Printer Settings > Printer: From the Medium list, select the loaded medium. 

5. Job > Printer Settings > Printer: Under Calibration Set, select Custom. Under Printer Calibration, select 
the printer calibration from the starter kit according to the results of the total area coverage test 
(for example, Epsonx880_8c_V1_240.mx3). 

6. Image > Color Management > Proof Output:  From the Proof Standard list, select Custom. Under Profile 
(MX DeviceLink / ICC Input), select a linear MX4 (default path: C:\Program 
Files\GMG\ColorProof05\Profiles_Linear\CP_linear.mx4). 

7. Click OK to print the job. 

How to measure the test chart with an external spectrophotometer  

1. Start GMG ProfileEditor. 

2. On the File menu, click Open and select the printer calibration you have used when printing the TC3 test 
chart (for example, Epsonx880_8c_V1_240.mx3). 

3. On the Measure menu in GMG ColorProof, click All Target Values. 
The test chart measurement dialog box opens. 

4. Click the browse button and browse your folders. In the templates folder, select the chart template 
corresponding to the test chart (with the same name), for example, GMG_TC3_random_iSis.tpl. 

5. Insert the test chart printed in the job into the measuring device. 

6. Click the Measure button. 
The test chart is measured. Measured data is read as Target Values into the open MX4 file. 

7. Repeat steps 5 to 8 for the second page of the test chart (if any). 

The printer calibration file is now ready to use. You can now set up a calibration set and then calibrate the 
printer. 

See also: 

• "Setting up a Calibration Set" on page 20 

• "GMG CaliWizard" on page 21 
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3.  Creating the Gamut File for MX4 Color Profiles 

Note:  To make sure that the printer is still in the same state, this step must be done immediately after creating 
the full gamut and MX printer calibration file. 

In this step, the gamut for this printer–medium combination will be created. It will be the base color space for 
creating MX4 proof profiles. 

The gamut is created in a similar way as the full gamut. The only difference is that the test chart is printed with 
the printer calibration. 

The input values (measured from the color patches) are computed with the printer calibration to produce the 
output values (the color values the software outputs to the printer driver). The measurement values for the 
fulcrums in the test chart describe the gamut of this printer–medium combination. Thus, the gamut file describes 
the color space that the printer is able to print according to its technical specifications and according to the 
medium and print mode in the "calibrated state" after calibration.  

It is recommended to print the test chart twice and average the results to achieve a reliable result. 

How to print the gamut test chart for MX4 color profiles 

1. Create a new job in GMG ColorProof and add the calibration test chart corresponding to the printer and 
measuring device (for example, GMG_ECI2002_random_iSis.tif) from the Testcharts subfolder of the main 
program folder to the job. 

2. Click Open to edit the job in the Manual Job Manager. 

3. Job > Printer Settings > Printer: From the Printer list, select the installed printer you want to use, for 
example, Epson 4880. 

4. Job > Printer Settings > Printer: From the Medium list, select the loaded medium. 

5. Job > Printer Settings > Printer: Under Calibration Set, select Custom. Under Printer Calibration, select 
the new printer calibration created in the preceding steps (for example, Epsonx880_8c_V1_240.mx3). 

6. Image > Color Management > Proof Output:  From the Proof Standard list, select Custom. Under Profile 
(MX DeviceLink / ICC Input, select a linear MX4 (default path: C:\Program 
Files\GMG\ColorProof05\Profiles_Linear\CP_linear.mx4). 

7. Click OK to print the job. 

How to repeat the measurement for averaging measured data 

• In the GMG ColorProof History view, select the printed job and print the test chart again. 

How to measure the test chart with an external spectrophotometer  

1. Start GMG ProfileEditor. 

2. On the File menu, click New CMYK MX4. 

3. Select the used printer type, for example, Epson Stylus Pro 4880 from the Printer list. 

4. Select the used measuring device, for example, Eye-One iSis, from the Measuring Device list. 

5. Under Measurement Chart, select ECI2002. 

6. Click OK to create the new profile. 

7. On the Measure menu in GMG ColorProof, click All Target Values. 
The test chart measurement dialog box opens. 

8. Click the browse button and browse your folders. In the templates folder, select the chart template 
corresponding to the test chart (with the same name), for example, GMG_ECI2002_random_iSis.tpl. 

9. Insert the test chart printed in the first job into the measuring device. 

10. Click the Measure button. 
The test chart is measured. Measured data is read as Target Values into the open MX4 file. 

11. Repeat steps 5 to 8 for the second page of the test chart (if any). 



  3.  Creating the Gamut File for MX4 Color Profiles

  19

12. On the Import/Export menu, point to Export Target Values, and click Text File. 

13. Save the file as xx_gamut_1.txt file. 

14. Insert the test chart printed in the second job into the measuring device. 

15. Repeat steps 5 and 6. 

16. Save the file as xx_gamut_2.txt file. 

How to convert the measured data to a gamut file 

1. In GMG ProfileEditor, open the new MX4 file again (or create a new one as described above). 

2. On the Import/Export menu, click Import Target Values. 

3. Browse your folders and select the xx_gamut_1.txt and xx_gamut_2.txt files while holding down the 
SHIFT key (multi-select). 
The measured data from all selected files is automatically averaged and loaded into the MX4 as Target 
Values. 

4. If an error message about missing fulcrums is displayed, confirm it with OK. 

5. On the Import/Export menu, point to Export Target Values, and click Gamut File. 

6. Save the full gamut file under an appropriate file name, for example, as Epson_4880_<print 
mode>_<medium>_V1_<measuring device> _<UVcut>.csc into the same folder where you saved the 
printer calibration file. 

The resulting gamut file will be linked to the final MX3 printer calibration file in the step "Creating an MX4 
Proof Profile". 
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4.  Printer Calibration 
With the Calibration Set concept, printer calibration is as easy as it could possibly be: The target values are 
linked to the corresponding printer–medium combination and the measuring device in the GMG ColorProof 
database. 

After connecting the measuring device to the computer and starting the Calibration Wizard (GMG CaliWizard), 
GMG ColorProof automatically detects all connected measuring devices and you simply have to select the 
spectrophotometer you want to use for the calibration. If the printer features an integrated measuring device, the 
calibration can be completely automated by using the GMG AutoCali Wizard. 

The initial calibration (MX3, MXC, or MX4) file is defined in the calibration set. The appropriate target values 
are automatically extracted from the database. The updated printer calibration is then automatically saved after 
the successful calibration. The next time you start the calibration, the last saved calibration is used as a basis for 
the new calibration. 

4.1  Setting up a Calibration Set 

GMG provides predefined calibration sets for GMG Proof Media. These sets are in read-only mode and cannot 
be modified. You can set up custom calibration sets for using custom print media. 

You need to set up the print medium first in the Media list before you can set up the calibration set. You need 
to set up the calibration set first before you can set up the proof standard. 

You need to set up one calibration set for each print mode (or other hardware parameter that directly affects the 
printed colors such as the ink set) that you are going to use. A print mode needs to be handled in the same way 
as a separate printer. You need to perform a full calibration for each ink set and print mode you are going to 
use. 

Note:  The name for a calibration set is automatically generated from the printer–medium combination and 
from the print mode settings. The Version name is the unique identifier that can be used to identify a custom 
calibration set in the calibration set list view or in the job/workflow dialog box. GMG calibration sets have 
version numbers V1, V2, and so on, but you can use any custom number or text string that is suitable for you as 
a unique identifier. 

How to set up a new calibration set 

1. Click the System button on the navigation panel on the left of the main window. On the System menu, 
point to Calibration Sets, click New and then click the Properties tab. 

2. Select a printer from the drop-down list. 
Available print modes will be displayed below the drop-down list. 

3. Select a print medium from the drop-down list. 

4. Enter a version number. The version number serves as a unique identifier if you have several versions of 
the same printer–medium combination. It is advisable to use a naming convention, for example, V1, V2, 
V3, and so on, but you can enter any string you like. 

5. (Optional) Select an ICC Printer Profile, if you want to use ICC based color management. 
 

How to add printer calibration files to the calibration set 

1. Click the Measurement tab. 

2. Click the + button to add a measuring device and the corresponding printer calibration and gamut file. 

3. Select the measuring device that you will use for this printer from the list. 

4. In the Initial Calibration column, click the browse button, browse your folders, and select the printer 
calibration file. 

5. In the Gamut column, click the browse button, browse your folders, and select the corresponding gamut 
(CSC) file. (Do not select the full gamut file.) 

6. To set up more measuring devices, repeat steps 2 to 5. 
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How to set up quality criteria for the printer calibration 

1. Click the Quality Criteria tab. 

2. Select the quality criteria that you would like to set for this calibration. If the quality criteria are not met 
anymore, print jobs for this printer–medium combination will be put on hold until the printer is 
successfully recalibrated. 

4.2  GMG CaliWizard 

GMG CaliWizard is used to calibrate printers with an external measuring device (for printers that do not support 
an integrated measuring device). 

The wizard will lead you through all steps required for the calibration. It runs fully automatically in the 
background. You can use other printers in the meantime. You can also set up jobs for the same printer that 
currently runs the calibration. They will be printed after the calibration will have been finished. 

GMG ColorProof uses multiple iteration cycles, similar to a control loop, to optimize the calibration. The steps 
of a cycle are visualized in the wizard. The currently active step is highlighted by a white background color. 

How to start GMG CaliWizard 

1. Click the Output button on the navigation panel on the left of the main window. 

2. Select the printer you want to calibrate from the Available Printers list. 

3. Select the calibration set you want to use from the Available Printer Calibrations list. 

4. Click the CaliWizard button  on the right side of the calibration set. 
The GMG CaliWizard is started. 

5. Follow the instructions of the wizard. 

4.2.1  Step 1: Print Calibration Test Chart 

When calibrating a printer, a printer calibration test chart is printed with a separate color patch for each fulcrum 
in the printer calibration file. During the first printer calibration, the output color values corresponding to the 
input color values are taken from the printer calibration file that is linked as Initial Calibration in the calibration 
set. 

The test chart job will be added to the job list with highest job priority. It is handled like any other job. The job 
name shows the iteration cycle. 

4.2.2  Step 2: Measure Calibration Test Chart 

The color values of the printed patches are measured (Current values) with the spectrophotometer and 
compared to the Target values. The wizard calculates new output values based on the deviation of the 
measured values from the target values. 

4.2.3  Iteration Cycle  

If the current values of the first cycle are already within the tolerances (indicated by a green status lamp in the 
Results column), the wizard will proceed to the final step. 

A failed iteration will be indicated by a red status lamp in the Results column. If the iteration fails, steps 1 and 2 
will be repeated: The test chart will again be printed with the new output values and measured. 

You can show a table with all measured and target values for all patches by selecting an Iteration Cycle from 
the list and clicking the Details button. This can give you a hint on where to look for the problem if the printer 
cannot be calibrated. For example, if there are prominent color deviations in a specific color channel, you 
might need to replace the ink or clean the print heads. If the paper tint values (0, 0, 0, 0) are out of tolerances, 
you might have loaded the wrong media type into the printer. 

4.2.4  Final Step: Evaluate and Finalize Calibration 

The iteration cycle is iterated until one of the following occurs: 

 The measured values are in the tolerances of the target values. Printer status = calibrated. The printer 
calibration file with the new output values is automatically saved after a successful calibration. 
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 The maximum number of iterations is reached. Printer status = not calibrated. 

The next time a calibration is started for the same printer–medium configuration, the output values are taken 
from the last saved printer calibration file. This way, the number of iterations you need for a successful printer 
calibration is minimized (saving valuable time and media). 

 
Fig. 3 GMG CaliWizard after successful calibration. 

The measured (current) values of the first iteration cycle (1) were outside the tolerances defined in the Quality 
Criteria of the calibration set. Therefore, Print and Measure steps have been repeated in a second iteration 
cycle. 
The output values calculated after evaluation of the first cycle resulted in correct measured values in the second 
iteration. The printer status is set to calibrated and the printer can be used for printing. The updated calibration 
file is saved. 
You can click the Details button (2) to show all results. 
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5.  Creating an MX4 Proof Profile 

5.1  Creating an MX4 Proof Profile—Overview 

This chapter outlines the creation of an MX4 proof profile. 

The gamut file is a table that lists output values (that are sent to the printer) and the corresponding color values 
in Lab. When creating an MX4 proof profile, the gamut file defines which output values needs to be sent to the 
printer for achieving a target Lab value. After importing the target values from the characterization data (for the 
target printing condition that you want to simulate in the proof, for example, for ISO Coated v2 
(FOGRA39L.txt), the target values are matched with the gamut to define the output values of the profile in a first 
step. 

The resulting profile is then used as a basis to print a standard test chart. Following that, the profile is 
optimized in an iterative cycle by comparing the measured color values with the target values. 

Note:  A gamut file is valid only for the specific printer–medium combination and measuring device that were 
used when creating the gamut file. As noted in the topic on creating a gamut file for MX4 profiles (see "Creating 
the Gamut File for MX4 Color Profiles" on page 18), please make sure to use the same measuring device when 
creating the MX4 proof profile. Ideally, environmental conditions such as ambient temperature and humidity 
should also be standardized. 

 
Fig. 4 Creation of an MX4 proof profile. 

The flowchart provides an overview of the steps involved in creating a new MX4 color profile.  
After selecting basic parameters (for example, the gamut file) in GMG ProfileEditor, target values will either be 
measured or imported. The CMYK color values will be calculated from the Lab target values. The MX4 file will 
be saved.   
Following that, a test chart (in our example: ECI2002) will be printed (with the appropriate calibration set). The 
current values of the print will be measured and compared to the target values. The profile will be recalculated 
and another test chart will be printed with the recalculated profile. These iterative steps (printing, measuring the 
current values and recalculating) need to be repeated until the current and target values meet within the desired 
Delta E tolerance. 
(A Delta E value of 1.0 is assumed to be barely perceptible to a trained eye.) 
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Having completed the color profile, you can additionally perform some manual corrections to attain a perfect 
visual match between the print result on the printing machine and the proof. 

5.2  Creating an MX4 Proof Profile—Short Summary 

How to create an MX4 proof profile 

1. On the Tools menu, click ProfileEditor to start GMG ProfileEditor. 

2. On the File menu, click New CMYK MX4. 

3. From the Printer list, select the printer for which you want to create the profile, for example, Epson Stylus 
Pro 4880.  

4. From the Gamut list, select the newly created gamut (csc) file. 

5. Select the measuring device and test chart, for example, ECI2002, you want to use for measuring the 
profile data. 

6. Confirm with OK. 
An empty MX4 profile is created. 

How to import the target values and define the output values 

1. On the Import/Export menu, click Import Target Values, and select the characterization data for the target 
printing condition you want to simulate in the proof, for example, FOGRA39L.txt. 

2. On the Measure menu, click Calculate with Target Values. 
The target values will be computed with the gamut file to produce the output values of the profile. 

3. Save the MX4 profile. 

The resulting profile can already be used as a proof profile. However, it is recommended to optimize the profile 
in the following steps to achieve high-quality proofing. 

How to iterate the profile (in short) 

1. Create a job with an ECI2002 test chart and print it using the new MX4 profile (last version) and 
calibration set. 

2. On the Measure menu in GMG ProfileEditor, click All Current Values. 

3. On the Measure menu, click Calculate with Target and Current Values. 
The measured values will be compared to the target values. Output values will be adjusted accordingly. 

4. Save the MX4 profile. 

5. Repeat steps 1 to 4 until the deviation (delta E) between Target Values and Current Values meets your 
requirements. 

The proof profile is now ready to use. You can now set up a proof standard. 


	1.  Creating Custom Printer Calibrations and Profiles
	1.1  Introduction
	1.2  Components Used in this Tutorial
	1.3  Spectrophotometer Settings
	1.4  Calibration File Formats

	2.  Creating a New Printer Calibration for Custom Media
	2.1  Creating a New MX3 Printer Calibration
	2.2  Test Charts
	2.3  Choosing a Suitable Media Type and Print Mode
	2.4  Creating a New Print Medium
	2.5  Advanced Media Settings
	2.6  Preparations
	2.7  Testing the Total Area Coverage of the Printer–Medium Combination
	2.8  Creating the Full Gamut File
	2.9  Creating Target Values for Printer Calibration

	3.  Creating the Gamut File for MX4 Color Profiles
	4.  Printer Calibration
	4.1  Setting up a Calibration Set
	4.2  GMG CaliWizard

	5.  Creating an MX4 Proof Profile
	5.1  Creating an MX4 Proof Profile—Overview
	5.2  Creating an MX4 Proof Profile—Short Summary


